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Introduction

CPRS Search Tool was created under the VA’s innovation program by Document Storage Systems Inc.

The VA provides search functionality within the Medical Notes and Laboratory sections of CPRS for text
and data. Many of the other sections in CPRS contain a large amount of data, and do not have search func-
tionality available for the VA health care providers. This causes extensive research and manual retrieval of
data by health care providers, which is inefficient and time-consuming.

Search options and capabilities provided by CPRS Search Tool give clinicians the ability to obtain health
care information that was previously unavailable or missed. CPRS Search Tool also helps to improve

workflow, efficiency and health care provider’s access to patient history.

This User and Administrator Guide describes the features and capabilities of CPRS Search Tool, and how
to use them.
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Overview

The Search Tool is located to the right of the drop-down menus at the top left section of the CPRS screen:

& ¥istA CPRS in use by: Programmer,One {172.19.100.95)

Fil= Edit Wiew Tools Help Search

SEVENTEEMN _PATIENT Vizit Mot Selected Frimary Care Team Unazzigned
BEE-00-0017 Apr OF 1335 [77] | Provider: PROGRAMMER OME

Figure 1: CPRS Tool Bar

If the Search button is disabled (greyed out), the user needs to contact the System Administrator to have
the dynamic link library (dll) option added to the system.

CPRS Search Tool is organized into two main parts: Standard search and Advanced search. Both Standard
and Advanced searches have essentially the same core capabilities, but Advanced allows searches that
include date ranges where applicable, as well as additional search options that are specific to TIU Notes,
Orders, and Reports.

| e namnes scveviocoe® b ey ]
CPU Priarity
= CPRS Search Tool
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@ CPRS Application
Standard Search | advanced Search | Search Resuks |
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Figure 2: Standard Search
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Figure 3: Advanced Search

The CPRS Search Tool has the following capabilities:

* 3 pull-down menus: File, Options, and Help.

* Search Terms and Quick Search which speed up a search.

3 tabs for searches: Standard Search (default view), Advanced Search and Search Results.

* Individual search areas which allow separate terms and date ranges (Advanced Search) for each of
the six CPRS tabs (Discharge and Notes are included in TIU).

¢ The Clear All button clears all the search terms to start anew.

¢ The Save Std Search button saves the search terms for future use.

¢ The Search button initiates a search, and the Cancel Search button cancels the search.

* The CPU Priority section of the screen has two radio buttons, Patient Record Search and CPRS

Application, which allow the user to prioritize their computer resources to perform a search or work

in CPRS.
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The Filter By section of the screen has 3 radio buttons, Signed Notes, Unsigned Notes, Uncosigned
Notes, which allow the user to filter and adjust the TIU returns.

* The Order Status drop-down menu allows the user to select the status of orders to be searched.

The Select Report button allow the user to choose reports to run and search.

The Total Found section of the status bar shows how many instances of the search term were found.
The five areas that can be searched are: TIU Notes, Problem Text, Consults, Orders, and Reports.

To perform a Standard search, search terms (words, values, etc.) are entered into the applicable text box of
the desired search area, e.g., Consults. The Search button is then clicked, and the search is initiated. Any
search terms that are found are presented on the Search Results tab as a “drillable” list; i.e., a tree-view,
from which specific search results may be selected, with any found search terms displaying in bold font,
and a user-selected color.

Advanced search works just like Standard search, but allows search results to be filtered by date-range.

CPRS Search Tool has the capability to perform searches with or without case-sensitivity, as well as whole
word and partial word.

Search terms can be saved for future use, and are user specific. One of the search areas supported by CPRS
Search Tool is CPRS Reports. User selected reports can also be saved for future use to avoid having to
select report(s) of interest each time a report search is required.

CPRS Search Tool offers users a selectable CPU Priority, which gives processor precedence to either
CPRS or the CPRS Search Tool, at the user’s discretion. This feature helps to ensure that the performance
of CPRS is minimally impacted while CPRS Search Tool is running.

CPRS Search Tool also offers some time-saving features that allow for quicker search term entry when

searching multiple areas of interest, as well as a way to search all areas at once by using a simple dialog
box.
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Drop-Down Menus

File Menu

|File Cptions  Help

[t
Saved Searches... Chr+Yy

Exik CErl+i

Figure 4: File Menu

The File drop-down menu has 2 active options, Saved Searches and Exit. The Saved Searches are lists
(Standard or Advanced) of user defined search terms (not search results) for edit boxes corresponding to
the TIU Notes, Problem Text, Consults, Orders, and Reports sections.

Clicking the Saved Searches option displays the Saved Searches screen, from which previously saved

searches can be selected. Standard and Advanced searches are saved in separate lists. Which list is cur-
rently available depends upon which tab (Standard or Advanced) is currently active.

M standard Searches E3

Aardwvark
Dave 1
Open Selecked Search
Dave orders =P
Oh best
Sea Gull
TEST ADYAMCED QElEtE Selected Search
TEST STAMDARD
a .
hieight weight etc Delete all Skandard
Searches

” Delete ALL Seatches

Close ]

Figure 5: Standard Searches Screen

The Search screen has 4 buttons:

* Open Selected Search — Opens a selected Standard search.

* Delete Selected Search — Deletes a selected Standard search.

* Delete All Standard Searches — Deletes all Standard searches appearing in the list.
¢ Delete All Searches — Deletes All searches, both Standard and Advanced.
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Options Menu

Patient Name: SEYENTEEN,PATIENT

File | Options Help

Title Searnch Chrl+T
[ ® Document Search Chrl+D

Search Term Bold Color... Chrl+-B

Skarm

TI « Show Results on Search Completion Chrl+H

Figure 6: Option Menu

The Options drop-down menu has the following options:
 Title Search — Compares user-defined search terms against record titles. The text in the body of a
record is not searched. Standard searches default to Title Search.

* Document Search — Compares user-defined search terms against the text in the body of records.
The text in the title is not searched. Advanced searches default to Document Search, but can also do
a Title Search.

e Search Term Bold Color — Opens a Color window which allows the user to set the color of the
searched text within the document display.

Color

Basic colors:

HEEET]

m co

BN NEEEAT
BN NEEET |
BN HETIEN
BN EEEET
AR EEENRT

o
#

Define Cuztor Colars > |
(1] I Cancel |

Figure 7: Color Window

*« Whole Words — Forces the search to match the entire word search text.
» Case Sensitive — Forces the search to match upper and lower text case.

* Show Results on Search Completion — Displays the Results tab of the CPRS Search Tool when
the search is complete.
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Help Menu

File Cptions | Help
Abowt. .. Chrl+L
] Shows Broker History  ChrlHK

Figure 8: Help Menu

The Help drop-down menu has the following options:

* About — Provides information about the CPRS Search Tool including the version number.

About CPRS Search Tool |

CPRS Search Tool

Wersion: 1.0.0.0
Copyright & 2012

Memary Available: 2096616 KB
Warning This computer program iz protected by copyright
lavwy and international treaties. Unauthorized reproduction or
distribution of thiz program, or any portion of it, may result in
zevere civil and criminal penalties.

Document Storage Systems, Inc.
12575 US Hwey 1, Suite 200
Juno Beach, FL 33405

(5617 227-0207

kit ifaeaeyy dssine . comsd

Figure 9: About Screen

* Show Broker History — Technical support may ask the user to show the Broker History when track-
ing down a problem.

Il Broker Calls
Max Call: Retaned ; = _| = |
1010 ﬂ Last Cal Minus: 0 HI Prew Mest
DSIC =PAR GET WP _‘I
ParamS ..................

literal USR~D3MwaA SEARCH TOOL TERMS™STD:

T R ——

B of

Figure 10: Broker Calls Screen
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Pop-Up Menu

To access the pop-up menu, right-click anywhere in the screen. The menu displays the following options:
* Select All
* Copy Selection to Clipboard

* Find
: ATIEMT EIGHT F
Fle Oplions  Help
CPU Priority
. CPRS Search Tool
[ 1 Search Terme ] [ ?{_i Duick Search ] @ (PRS Search Toal
_ (PRS Appication
Standard Search | Adyanced Search  Search Resuks |
LOCARL TITLE: VIE (VISURL IMEPRIDMENT sSUCE) d
B TIU Notes afl [DRTE OF HOTE: JRN Zes, Z007@1L:05 EMTEY DATE: JRN Z&, ZO0OT7@L1L:0E
' I— RAUTHOR: CPRSNURSE, ONE E¥D COSICHER:
| L. DE/2B/2012 F-IBAD BLUNDER, VOMAM, KEWIN WRIGHT EER i EeETTED

L DB2B/2012 F-1BAD BLUNDER, VOM-N, KEVIN WRIGHT
L DE/20/2012 21 DAY CERTIFICATION, VEM-AN, KEVIN WRIGHT
L OB29/2012 CAISIS NOTE VEMAN, KEVIH WRIGHT
te BATAA012 SEE BREASTMAMMO, VCMAN, KEVIM WRIGHT
« 0BAT/2012 SBE BREASTMAMMO, VCMAN, EEVIN WRIGHT
05442012 Adverze Reactféliagy, VEM-IN, EEVIN WRIGHT
110242011 HEMATOLOGY CONSULT, WCMAM, EEVIN WRIGHT
11/02/2011 HEMATOLDGY CONSULT, WCMAN, EEVIN WRIGHT
11,/0242011 AMEMIA PROFILES. VCMAM, EEVIN WRIGHT
L 1042172011 ADDMISSIDN ASSESSMENT, VCMAN, KEVIN WRIGHT
S 10A7/2011 HEMATOLOGY CONSULT, VCMAN, KEVIN WRIGHT
L 100242011 AMEMIA PROFILES. VEMAN_ CHIEF O ROISTAFF
te 100242011 BLEEDING DISORDER, WCMAN, CHIEF O BOISTAFF
10/02¢2011 HEMATOLDGY CONSULT.VCMAM,. CHIEF O ROISTAFF
t- D8/26/2011 DENTAL COMSULT, VCM-M, EEVIN WRIGHT
02/26/2011 DENTAL COMSULT, WCMAM, KEVIN 'WRIGHT
071442010 MHS INTAKE, 45 CLINIC PATTERN, OME CPRSPHYS ICIAM
- M2A92010 MHTFINTERDISCIPLINARY TREATMENT FLAM. 3MIKE. ONE [
S (142642007 JMS SURGERY NOTE, SURGICAL CLINIC, ONE CPRSPHYSICLA!
Addendum to JMS SURGER'Y NOTE, SURGICAL CLINIC, ELEVEN
i 7 TEST. OME CFF 15
fo O772442012 Addendum to V1S [VSUAL IMPAIRMEMT SWCS), TEST. OME CPR
1072072005 MHTF INTERDISCIPLINARY TREATMEMT FLAM, MHLC WODMIC
+- OB/ /2008 Addendum o MHTR INTERDISCIPLIMAR'Y TREATMEMT PLAN,
052442004 Adverze Reacttlizigy, RADIOLOGY, OME CRRSPHYSICIAN
072842003 FBAD BLUNDER, 3 MIKE, DME CPRSPHYSICIAN
L. 100972001 REMINDER RESOLLITIONS, MIKE'S MEDICAL CLINIC, ZICHAEL
L. DR/OR/Z00T EAR CLEAMING [SBK) AUDIOLOGY. SEHUD K. BUHAM

i

Ao

L QB0 EAR CLEAMING [SBE]L AUDIOLOGY. SEHUD K. BUHRM

*r* YIS (VISUAL IMPRIGPENT EWCS) Has RDDENDR *7*

Call Type: DRUG INTERARCTIION.

Facility Appeinted PCP: PEYSICIAM,TELECARE OME (RED TERM)
o Resociate Provider Idemtified

Caller Besponse: RAPPT NEXT WEEE.

Protocolis} used: =Not identified=.

CPREPRTIENT . EIGHT F is a=z=igned to Caller Area WVEST PALN BERCH.

Patient Phone Huwber: SES-ZZZ2
<No Contact Phom-o thisl-os Eed--d.
Select Al Cirked,
RCDITIONARL CO Copy Seleclion bo Clpboard CirkC
Evraluation/Ma  Fg ChieF VISIT, NEV (35201).
Srarting at: —

Ending at: 1/26/2007 4 11:05:1E5 RN

Length: 0 minutes.

[Ruthor: CPRINURSE, ONE

Conversation with CPREPATIENT,EIGHT F has a chief complaine af:
identifieds.

<fa

Identified problem: DTHER UNSPECIFIED COUNSELING.

fes/ ONE CPRENURSE
CPRE WURESE
Signed: 0172642007 11:05

O7/24/20L2 RDDENDI
Tou may not VIEW this UNSIGNED Rddendum,

ETRATUS:; UNESIGWED

R e e S 0 D AR -
[ M Clear All ][ Ea Save 5td Search } [ 'J{i Search ] [ Cancel Search }
| Saaich Camplete: |Smarch Time: 3576 seconds [  [Total Found: 377 |e58 w962

Figure 11: Pop-up Menu
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CPU Priority

The CPRS Search Tool shares CPU allocation with CPRS. To speed the search tool retrieval, priority can
be set to the CPRS Search Tool at the upper right of the CPRS Search Tool screen. This setting also affects
the speed of the document processing on the Display Pane of the Search Results tab.

CPU Prioriky
ZPRS Search Tool

@' CPRS application

Figure 12: CPU Priority
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Performing a Search

Standard Search Tab

To perform a standard search:

1. Select the Standard Search tab on the Patient Record Search screen.

2. Choose any TIU filters, display preferences, or document classes.

3. Click in the Search Terms field and type in key words to search for, separated by a space. Then

choose the number of instances to display.

4. Active Orders is the default status. The user can select order statuses using the drop-down.

5. [Ifthe user has search terms for reports, select the reports to run.

CPLU Priarity
- HW] CPRS Search Tool S S
@ CPRS Application
Standard Search | advanced Search | Search Resus |
TIU Kotes
Search Terme Fiker by Sort by Diate Time:
| [ pom ] @ Signed Notes (Al fscanding
@ Descending

Max Resuks Dooument Class: Unisigned Notes
o 3 rount —_—— - .,
Problem Test
Search Terms
| Clear
Max Results
g [
Consults
Search Terms
! (@)
Max Results
l:"DO E Found:
Orders
Search Terms
| (@)
Max Results Order Stabus:

200 %) Found: 2. ActivejCurent =]
Reports
Search Terms
! (@)

Found: Select Reports
e e ——[T——
Tokal Found: 858 x 962 -

Figure 13: Standard Search Tab
6. Click the Search button.
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To search for terms (from either Standard or Advanced search) on Reports, first select the reports to run
and then search. Clicking the Select Reports button on the Reports area of the CPRS Search Tool opens

the following window which is identical to the CPRS Reports tab selection. The instructions are on the

window.

Standard Searches E

This form allows you to select which reports you would like to include in your search.
The search term(s) you enter will be applied to All selected reports.

To select a single report, click a report in the left pane, then click the '=' button to add it to your list.

To deselect a single report, click a report in the right pane, then click the '<' button to remaove it from your list.,
To deselect ALL reports at the same time, click the 'Delete All' bution.

*#** pamote Reports are NOT supported at this time ***

Available Reports

Selected Reports

- Clinical Reports

- Health Surnmary

[+ HDR, Reports

[+ Dept, of Defense Reparts

- Imaging

- araphing {local only)

- Lab Status

- Blood Bank, Report

[+ Anakomic Pathology

- Dietetics Profile

- Mutritional Assessment

- Witals Cumulative

- Procedures (local only)
Daily Order Summary

- Chark Copy Summary

- Qukpatient R¥ Prafile

- Med Admin Log (BCMA)

- Med Admin History (BCMA)
- Surgery (local anly)

- Progress Motes

[+ Progress Makes

[+ Event Capture

- Qrder Summary For a Dake Range

Abnormal

All Outpatient

411 Problem List

Chart Copy Summary

Chemn & Hematology

Comp & Pen Exans

Cytology

Daily Order Summary

Expanded ADT

Full Feport

Health Summary
Orders Current

Progress Notes

Treatments Provided

Close

Figure 14: Select Reports
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Search Terms Button

Patient Name: SEVENTEEN,PATIENT

File Options Help

[ 7% search Terms ][ 243 Quick Search ]

Figure 15: Search Terms

The Search Terms button (upper left of the CPRS Search Tool) opens the following window. This is a fast
way to enter search terms if they are the same for each area. The instructions are displayed in the window.

1. Click the Search Terms button.

2. Type in the terms in the Search Terms: box.

3. Select any or all of the CPRS areas to apply the terms to.

I Search Terms M=l E3
1) Enter all desired search terms in the "Search Terms' box below, with each term separated from
adjacent terms by one or more spaces.
2% If on Advanced search tab, enter Start Date and End Date.
3) Indicate the search area(s) of interest by checking one or more checkboxes in the 'Apply To' box.
47 Click the 'apply Search Terms' buthon.
Start Date: End Date: Apply To:
(mmiddfyyyy) | 1/1/2012 =] [8f13/2012 = )
search Terms: TIU Motes
;I Problem Te:xt
Consults
Crders
Reports
I
Clear Search Terms J ‘ Apply Search Terms l Close

Figure 16: Search Terms Window

4. Click the Apply Search Terms button.
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Quick Search Button

Patient Name: SEVYENTEEN,PATIENT

File Options Help

73 Search Terms ] [ ?{} Quick Search ]

Figure 17: Quick Search

The Quick Search button (upper left of the CPRS Search Tool) opens the following window. This is the
fastest way to perform a search terms. The instructions are displayed in the window.

1. Click the Quick Search button.
2. Type in the terms in the Search Terms: box.

3. Select a Start Date.

Il Quick Search M=l E3

Quick Search allows you to search all document types from the specified Start Date, until Today,
The search termis) you enter will be applied o All document types.

Enter all desired search terms in the 'Search Terms' box below, with each term separated fram
adjacent terms by one or more spaces.

Skart Date:
(mmiddfyvyy) | o]

Search Terms:

Clear Seatch Tetms

{ Search J Close

Figure 18: Quick Search Window

4. Click the Search button.
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Save Search Button

dmn B o) e |

Tokal Found: 58 x 962

Figure 19: Save Standard Search

Once a search has been entered, it can be saved for future use. Saved searches are specific to the Standard
Search or Advanced Search tab. Clicking the Save Std Search button (or the Save Adv Search button if
on the Advanced Search tab) opens the naming prompt. Once saved, the search is available from the File
drop-down menu (see the Drop-Down Menus section for more information).

Mame of Standard search |

Search names are case-sensitive

Flease enter a case-sensitive name Far
this search:

(0] 4 I Cancel

Figure 20: Name of Search
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Advanced Search Tab

The Advanced Search tab (second tab top left) has identical features to the Standard Search, but offers

start and stop date ranges for all areas. The Search Terms and Quick Search buttons also prompt for date
ranges, but otherwise function the same as in the Standard Search. Advanced searches can be saved in the
same manner as a Standard search, but are visible from the File drop-down menu only on the Advanced

Search tab.

1. Select the Advanced Search tab.

2. Choose any TIU filters, display preferences, or document classes.

Click in the Search Terms field and type in key words to search for, separated by a space. Then
choose the number of instances to display.

4. Select a Start Date and End Date for the search.

Advanced Searches

#*F Remote Reports are NOT supported at thig time ***

This form allows you to select which reports you would like fo include in your search.
The search termis) you enter will be applied o All selected reports,

To select a single report, click a report in the left pane, then click the '=' button to add it to your list.

To deselect a single report, clidk a report in the right pane, then click the '<' button t© remove it from your list,
To deselect ALL reports at the same time, click the 'Delete All' buthon.

Available Reports

Selected Reports

[#- Clinical Reports
- Health Surnmary
[#]- HDR. Reports
[+ Dept. of Defense Reparts
- Imaging
- araphing {local onlky)
- Lab Skatus
- Blood Bank Report
- Anatamic Pathaology
- Digketics Profile
- Mutritional Assessment
- Wikals Cumnulative
- Procedures (local only)
- Daily Order Summary
- Order Summary For a Date Range
- Chart Copy Summary
- Oukpatient R Profile
- Med Admin Log (BCMA)
- Med Admin History (BCMA)
- Surgery (local only)
- Progress Motes
[+ Progress Nokes
[+ Event Capture

Allergies

Chem & Hematoloogy
Patient Data Summary
Pharmacy All Outpatient

Close

Figure 21: Report Selection

5. Click the Search button.
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Cancel Search Button

To cancel a search in progress, click the Cancel Search button on the lower bar. Selecting a different
patient in the CPRS also cancels a search.

P Y= - —

Figure 22: Cancel Search Button

Close Button

To close the CPRS Search Tool without closing CPRS, click the Close button in the lower right of the
CPRS Search Tool window. Both applications close if CPRS is closed after the user receives a Warning
Message stating that the search data will not be saved.

con Jmn] [ e ][ s =]

Figure 23: Close Button
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Search Results Tab

Selecting the Search Results tab displays any available search results. If the Show Results On Search
Completion option is selected on the Options drop-down menu, the tab automatically displays. The
Results Pane (left side of the screen) displays documents returned by the search in an expandable outline
form. Selecting a document in the results pane displays the text in the Details Pane (right side of the
screen) with the search term text in a bold, colored font.

Paotient Name: SEVENTEEN,PATIENT

Fls Options Help
CPLI Pricaiky
= CPRS Search Tool
[?l Search Tetig ][ ?{; Ghsch Search ] 9 CPRS Search Tool
CPRS Agplication
Syandard Search | Adyanced Search  Search Resuks |
LOCAL TITLE: ADVANCE DIRECTIVE COMPLETED _‘-I
B TIU Moles | |STANDARD TITLE: ADVANCE DIRECTIVE
CF DIRECTIVE COMPLETED. 20 MINUTE. FIFTYNINE L IDATE OF NOTE: MAY 1€, 20078l0:0% ENTEY DATE: HAY 16, Z00T@l0:09
Lo = e e e LIRS AUTHOR: LABTECH, FIFTYHINE EXP COSIGNER:
04/01/2004 AUDIOLOGY - HEARING LOSS CONSULT, GENERAL MEDICINE URCENCY: STATUS: COMPLETED
(3/31/2004 GEMERAL MEDICINE MOTE. GEMERAL MEDICINE. SPECLAL LAk
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12/30/1938 NURSING NOTE, HURSING. TWOHUNDREDMNINE TYFIVE PRO
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02N 29T Genesal Note. 74 GEN MED. TWOHUNDREDMINE TSI FROVIC

El Problem Text
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- Consults
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B Repots

Fharmacy A1 Qutpatient
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Figure 24: Search Results Tab
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Administrator Guide

Minimum Requirements

The minimum software requirements for the CPRS Search Tool are:

* CPRS v1.0.27.90 (modified for CPRS Search Tool)

» DSSPatientRecordSearch.DLL version 1.0 or higher in the same directory as CPRSChart.exe
(v1.0.27.90)

* Required Namespace: DSIWA
« KIDS Build DSIWA CPRS_SEARCH TOOL 1 0.KID

Configuration Guide for the VA Sandbox

CPRS Location

On the VA Sandbox, the CPRSChart.exe (v1.0.27.90) file is located in S:\Innovation-259. There may be
various versions of CPRSChart in that directory. The most current version, and the one pointed to by a
Sandbox desktop shortcut is CPRSChart.exe.

Patient Record Search Tool DLL Location

The CPRS Search Tool is implemented as a .DLL (dynamic link library), which is launched from the
CPRS main menu by clicking the Search button.

The .DLL filename is DSSPatientRecordSearch.dll. This file must reside in the same directory as

CPRSChart.exe (v1.0.27.90). On the VA Sandbox, that directory is S:\Innovation-259. Both
CPRSChart.exe (v1.0.27.90) and DSSPatientRecordSearch.dll must be physically located in that directory.
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Create a Desktop Shortcut to CPRS 27.90

Create a Desktop shortcut to CPRSChart.exe (v1.0.27.90). Right-click and select the Properties option

from the drop-down menu. In the CPRS Search Tool Properties screen, select the Shortcut tab and enter

the following:

Target: S:\Innovation-259\CPRSChart.exe s=172.19.100.95 p=9259

Start In: S:\Innovation-259

CPRS 27.90 - CPRS Search Tool Properties K E |

General Shortcut | Compatibiity | Security | Previous Versions |

& CPRS 27.90 - CPRS Search Tool

Target bype; Applicaton

Target bocation: Innovation-2539

Target: |on-259"~tF’HEl:hart.exe $=172.19.100 85 p=0259

Skart irv IS:MInmvatiDn-Eﬁ‘S

Shortcut key: IN one

Burn: IN arral wardow j

Comment: |

Find Targst... | Ehmgslcm..l Advanced... |

(1] I Cancel finnly Help

Figure 25: Shortcut Tab

To run CPRSChart.exe, double-click the Desktop shortcut. Attempting to run it by double-clicking the

CPRSChart.exe file in the Innovation-259 folder will not work. This is because CPRS needs the Server and

Port numbers from the Shortcut Properties (above).
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Cache Terminal Instructions

To get a Terminal session, SSH must be used. Terminal from the Caché Cube menu will NOT work. To ini-
tiate a Terminal session on the VA Sandbox, do the following:

1. From the Start menu, under All Programs, select Attachment Reflections, Host — UNIX, and
Open VMS.

2. Select the Connection Setup... option from the Connection drop-down menu.

& untitled - Reflection for UNIX and Open¥MS

File Edt | Connection Setup Macro Window Help
D> oo FIQEIES| N2

— Connect to Best Metwork
[isconmect
Serd Break F5
Reset ]
Trace Ir.
T-1 b

Figure 26: Connection Setup

3. Change to SECURE SHELL.

Connection Setup E |
-Connect using- | C '
" Best network TELMET a
& Network oK
" Seiial port Cancel |
" Maodem
[n&ling Froperties |
- Connection options
Host name: I _ﬂ
SSH config scheme: | E' Defauits |
Uszer name: | Help |
Secunty., | Connect Macro... l More Settings... |

Figure 27: Secure Shell
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4. Use vaphsdb05 for the Host name.

Connection Setup ﬂ E |

— Connect using | T
" Best network
& Network oK
" Serial port Cancel
" Madem
[N&lng Froperties I
— Connection options
Hozt name; Ivaphsdl:u[lf- j
S5H config scheme: [ ~| Defauits
Uzer name:; | Help

Security... | Connect Hac:m...l More Settings... |

Figure 28: Host Name

5. Click Connect. If a “Host Key Authenticity” message displays, click Always.
6. Log in with:

Username: vhaino259
Password: vhaino259

Comectonsety ———————————_@H|

— Connect using | C '
" Best network
* Network OK
" Senal port Cancel
" Maodem
[aling Froperties I
— Connection options
Host name: Ivaphsdl:n[lf- j
SSH config scheme: I El Dolaukts
User name: IvhainDEEE( Help
Security... | Connect Macro... I More Settings... |

Figure 29: Username
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CPRS Logins on the VA Sandbox

The following CPRS Access/Verify Codes are pre-configured for general use on the VA Sandbox:

VistA Administrator

Access code: 01vehu
Verify code: vehu0l

Doctor/Provider

Access code: 1radiologist
Verify code: radiologistl

Pharmacist

Access code: 1pharmasist
Verify code: pharmasistl

VistA Programmer

Access code: 1programmer
Verify code: programmerl
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